# Table of Contents

**DISCLAIMER:** ................................................................. 2  
Planning with PlanBee ........................................................................ 3  
Planning Philosophies ...................................................................... 4  
The Calendar ................................................................................ 4  
Starting a New Project .................................................................... 5  
Spreadsheet view of Project .............................................................. 5  
   Editing or Changing a Task .............................................................. 5  
   Adding or Inserting a Task .............................................................. 6  
   Deleting a Task ........................................................................ 6  
   Copying a Task ......................................................................... 6  
   Splitting a Task ....................................................................... 6  
   Working Day or Calendar Day Selection ..................................... 6  
   Emphasized Tasks ................................................................... 6  
   Group/Heading levels ................................................................ 7  
   Moving or Rearranging Tasks .................................................... 7  
   Show More Rows button ............................................................. 7  
Precedence (Link) Details ................................................................ 7  
Navigating Around Your Plan .......................................................... 9  
Fixed Dates ................................................................................ 9  
   Exporting Results to Clipboard .................................................. 9  
Recalculation Options ................................................................... 10  
   Float and Criticality Options ...................................................... 10  
Administrative Details ................................................................... 10  
Language for Dates ....................................................................... 11  
Resource Assignment ..................................................................... 11  
   The Resource Calendar .............................................................. 11  
   Resource Leveling Techniques .................................................. 12  
Saving and Loading the Resource Master List ................................ 14  
PERT View ............................................................................... 14  
   Auto Alignment of PERT chart .................................................... 15  
   Printing a PERT Chart .............................................................. 15  
   Using PERT Chart in other applications ..................................... 15  
GANTT (Bar Chart) View of Project ................................................. 16  
Reporting Progress with PlanBee .................................................... 16  
Printing Reports .......................................................................... 17  
The Sample Plans ......................................................................... 18  
   Newsletter: ........................................................................... 18  
   Charity Lottery: ..................................................................... 18  
   Pipeline: ............................................................................... 18  
   Advertising Campaign: ............................................................. 18  
   The Great Mail Train Robbery ................................................... 18  
Upgrades & Fixes ......................................................................... 19  
Uninstalling PlanBee ..................................................................... 19  
Reinstalling or Transferring PlanBee ............................................... 19
DISCLAIMER:

The supplier and author bear no liability to the licensee or any other person or entity for any damage or loss, including special, incidental or consequential damages caused by this product directly or indirectly. The software is supplied "as is" without warranty of any kind, either expressed or implied. Warranties of merchantability or of fitness for any purpose are specifically disclaimed.
Planning with PlanBee

PlanBee is a critical path planning tool. It allows you to specify tasks and their durations, and will then calculate the earliest and latest start and finish dates for each task, based on dependency links which you give it. It will calculate "Float", the amount of spare time that a given task has in the schedule as an indication of how important that task is to the overall timing of the project.

The results are made available to you in several forms, either for printing or for incorporation in other documents or programs.

“Float” for a task is defined as the number of days by which the finish of a task may be delayed without affecting the overall finish time of the project. Float can be calculated in terms of working days for that task or as calendar days, depending on an option on the Project Details panel (repeated on the Float and Criticality options panel). In the case of a task which uses calendar days for its duration specification, both options give the same result.

PlanBee reports the total amount of float in its main grid. However in the Gantt (bar) chart it further indicates the type of float.

Float which can be “used up” without affecting other tasks is known as "Free Float", float which will affect the timing of other tasks is known as "Interfering Float". PlanBee shades the edges of that portion of a bar which denotes interfering float. In task 132 above, free float exists from October 8th to 8:00 am October 16th and interfering float from October 16th to November 1st. This means that task 132’s finish may slip to October 16th without causing a delay to any other task. If it slips beyond that date it will affect the timing of other tasks. All of the float in task 133 is interfering float, so any slippage will affect the timing of at least one other task.

Note that with PlanBee a “day” starts at 8:00 am and ends at 7:59 am on the following day. If a task has a duration of 1 day it will be considered to end on the day after it started and one minute before the start time. If the next day is a non-working day and the task duration is specified in working days, it will finish on the next working day.

If you are a new user of PlanBee, you may wish to experiment with the sample plans included. To access them, select the File Open menu selection or click on the button.

If a task has zero or negative float, that task is said to be “critical” and the sequence of critical tasks is called the “critical path” of the project. The float for critical tasks is displayed in red on the PlanBee spreadsheet view and you may highlight critical tasks in red in both the Gantt and PERT charts by clicking the appropriate check box in their windows (this also highlights the charts when printed on a colour printer).

In this example, any delay in task 326 will delay the finish of the entire project.

As an enhancement to the Gantt chart, PlanBee will optionally show dependency links:

The colours used are optional (you may change them by using an Options... menu item. Here links which are on the critical path are shown in red and others in magenta.
You may notice that sometimes a task on what looks like the critical path is not zero float. This can occur when some durations and lags are specified as "working days" and some are specified as calendar days. If a "working day" task is dependent for its start on a "calendar day" task, and the "calendar day" ends on a Saturday, normally the working day task cannot start until the following Monday. Therefore, the calendar task would have some float, because it could also continue on the Sunday if necessary.

If you "fix" one or more dates in PlanBee, all of the other activities are scheduled around them (this would usually happen when an actual finish date becomes known). Sometimes this cannot be done for some of the tasks and in those cases "negative float" arises. This is the number of days which must be "saved" if the fixed dates are to be met. Usually, you would assign additional resources to those tasks in order to reduce their durations.

Planning Philosophies

Some people plan from a "start to finish" viewpoint, others plan from a "finish to start" viewpoint.

The latter is often most successful when planning a particular kind of project for the first time. You first define "completion". "What is the last thing that has to be completed, and when we've done it we've finished?" (Note that this is often not the thing you first think of. If you are publishing a newsletter, the last task may not be mailing it, it may be paying the bills.)

If there are several independent final events in different areas of the project, you may need to specify an artificial "completion event" of zero duration, which cannot start until all of these final events are completed. This ties together the end point of the project.

Once the final task/event is defined, a list of every task which must be completed before this task is either started or finished is needed. These tasks are then set up as "precedents" to the final task.

Each of these precedent events then requires a list of its own precedent events, until none of the tasks defined has any unlisted precedents. At this time you have a plan.

Note that you may define these tasks in gross terms initially and break them down into smaller portions later.

PlanBee allows some short cuts for frequent tasks. For example, inserting a task is achieved by positioning the cursor in the row below the position you desire for it and then pressing the INSERT key, which results in a new blank task with zero duration and no links. Holding down the SHIFT key while pressing INSERT does this and also sets up a precedent link such that the new task becomes a precedent to the task below it, with Finish-To-Start dependency and no time lag. This speeds up defining chains of tasks. Holding down the ALT key while pressing INSERT does this and also sets up a dependent link such that the new task becomes dependent on the task above it, with Finish-To-Start dependency and no time lag. This speeds up defining chains of tasks.

If you hold down the ALT and SHIFT keys while pressing the INSERT key, the new task inserted will be a precedent to the currently selected task and dependent on the task above it. If this would result in circular dependencies, the link to the task above is blocked.

If the cursor is in the bottom row of the "Task" spreadsheet grid, pressing the DOWN ARROW key will add another task (don't worry if you do it by mistake, pressing [Ctrl][Delete] will remove any selected task which does not have dependencies). Holding down the SHIFT or ALT key while pressing the DOWN ARROW will make the new task dependent on the task above it.

Note that you may define these tasks in gross terms initially and break them down into smaller portions later.

PlanBee allows some short cuts for frequent tasks. For example, inserting a task is achieved by positioning the cursor in the row below the position you desire for it and then pressing the INSERT key, which results in a new blank task with zero duration and no links. Holding down the SHIFT key while pressing INSERT does this and also sets up a precedent link such that the new task becomes a precedent to the task below it, with Finish-To-Start dependency and no time lag. This speeds up defining chains of tasks.

If the cursor is in the bottom row of the "Task" spreadsheet grid, pressing the DOWN ARROW key will add another task (don't worry if you do it by mistake, pressing [Ctrl][Delete] will remove any selected task which does not have dependencies). Holding down the SHIFT key while pressing the DOWN ARROW will make the new task dependent on the task above it.

The Calendar

In any project, most tasks (otherwise called activities) are governed by a working day calendar. They do not proceed on weekends or holidays, but only on "Working Days". Other tasks or activities continue everyday. For example a continuous pour concrete operation must continue once started. Other things like the curing time of concrete or the time taken for grass to grow are controlled by simple elapsed days, ignoring the "Working Day" status.
PlanBe includes a working day calendar which covers the years 1900 to 2099. All dates before or after those dates are assumed to be working days.

The default working day calendar assumes that every day except Saturday and Sunday is a working day and every Saturday and Sunday is a non-working day. This status may be changed by clicking on a date on the working day calendar to "toggle" or reverse its status.

In PlanBee a "day" begins at 8:00am and ends at 7:59am on the following day.

The working day calendar for a project is saved as part of the project file. Additionally, the working day calendar may be saved separately using the "Save Calendar" function on the File menu. A previously saved calendar may be loaded into a project by using the "Load Calendar" function of the File menu.

By this means, one or more detailed calendars holding the working day and holiday status of a given jurisdiction for a long period may be created and saved for import into any project - particularly new projects.

For example, while Americans take off the Fourth of July, Canadians take off the First of July and the French take off the Fourteenth of July as national holidays. You can create an American, a Canadian and a French working day calendar and any others you want to use.

Note that clicking on the "Current Month" button of the working day calendar will display the current month, with the current day indicated by white digits.

The working day calendar may be displayed or hidden by clicking on the "Calendar" button of the toolbar.

**Starting a New Project**

To start a new project, select the File New menu item or click on the toolbar button. The system will display a panel for the entry of basic data about the project: Company Name, Project Name, Author Name and Account Information. You may enter anything you wish in these fields. The panel also displays a calendar for you to select the project start date. After entering this data, click on the OK button or the Close box in the upper left of the panel. Note that you may display the project data panel later (after you have defined at least two tasks) to change this information by clicking the button on the toolbar or by selecting the Change Project Options function on the File menu.

You may now define tasks either in the Spread Sheet window or in the PERT window. You must first enter data to define the first task shown on the screen. Many of the options on the toolbar are disabled until you have defined at least two tasks.

Many, but not all, task details may be entered from the PERT view of the project. All task details may be entered from the Spread Sheet view, including task name, task duration, task calendar (i.e. working days or calendar days), link (precedence) details, resource assignments, completion data and fixed dates (if any).

You may define linkages (precedents and dependents) at any time, however there are keyboard shortcuts for adding the most common linkages automatically while you are defining tasks.

**Spreadsheet view of Project**

The default (usual) view of a project is similar to a spreadsheet in which the task details are shown as a matrix of rows and columns in the Task Details grid.

Notice that the row number of the currently selected task has a pale blue background. Tasks which are dependent on the currently selected task have their row numbers displayed against a yellow background (pale for a direct dependent, dark for an indirect dependent). Tasks which are precedent to the currently selected task have their row numbers displayed against a violet background (pale for a direct precedent, dark for an indirect precedent). This gives a quick visual overview of project linkages.

When a new project is created, a single task of zero duration is created. You must enter an appropriate name and duration.

Most of the functions which can be performed via the keyboard can also be performed using the mouse by right-clicking the appropriate Task Name in the Task grid.

**Editing or Changing a Task**

The task names and duration by be edited by simply selecting and altering them. The dates are computed by the system.
Adding or Inserting a Task

When in the spreadsheet view of the project, pressing the [Insert] button on the keyboard inserts a new task above the currently selected task. Holding down the SHIFT key at the same time creates the new task as a precedent to the currently selected task. Holding down the ALT key at the same time creates the new task as a dependent of the task above it.

If you hold down both the ALT and SHIFT keys while pressing the insert key, the new task inserted will be a precedent to the currently selected task and dependent on the task above it. If this would result in circular dependencies, the link to the task above is blocked.

The Insert a Task and Insert a Precedent Task functions are also available on the Right-Click menu of the Task Details grid.

If the currently selected task is in the last row of the list, pressing the down arrow key will add another task row below it. Holding down the shift or alt key while doing this will create the new task row as a dependent to the task in the last row.

Deleting a Task

Holding down the [Ctrl] key while pressing the [Delete] will delete the currently selected task.

The Delete Task function is also available on the Right-Click menu of the Task Details grid.

Note that you may not delete a task until links between it and other tasks have been deleted. You may delete the precedent links to the task while it is selected. To delete a dependent link, you need to go to the "other end" of the link (click on the dependent task name in the yellow list to the right of the precedent list - once you have deleted the link you may re-select the task by using the GoBack button.

Copying a Task

You may copy a task’s name and duration and then insert the copy elsewhere by using the Copy and Insert Copy functions of the Right-Click menu of the Task Details grid.

Splitting a Task

Often, it is necessary to divide what initially appeared to be a single task into two (or more) tasks. PlanBee assists this process using a function on the Right-Click menu of the Task Details grid. If you select the Split Task function, the task will be divided into two tasks with a Finish To Start zero lag dependency between them on the following basis:

- All precedents to the original task will be precedents to the first portion of the split.
- All dependents of the original task will be dependents of the second portion.
- The duration of the original event is shared as close to equally as possible between the new portions.
- The same resources, manager, notes and cost code (Poe features) are assigned to the portions as were assigned to the original task.

Note: If there are "overlapping" dependencies (i.e. Start To Start or Finish To Finish) you may need to edit them to ensure that the result is what you intended.

A task may be repetitively split into as many tasks as desired.

Working Day or Calendar Day Selection

When entering a duration for a task, you may specify whether the task uses calendar days or working days by clicking the appropriate button in the Row Options section in the lower left portion of the screen or by checking or unchecking the appropriate entry on the Right-Click menu of the Task Details grid.

The standard default value for PlanBee assumes that durations are in working days for new tasks. However if a project has the majority of its tasks defined in calendar days, you may change the default for the current project by checkmarking a box on the Project Details panel.

Emphasized Tasks

You may elect to emphasize a task by checkmarking the Emphasized Task radio button:

This task will then be printed in bold type in reports and also emphasized in Gantt charts by a heavier outline. Additionally task emphasis may be used as a criterion when exporting task data to the system clipboard or a file.
In PlanBee Pro, there is an automatic emphasis feature which permits you to emphasize groups of tasks based on several criteria related to resource usage (selecting the resource from the resource master list panel) and to time schedules (using the calendar in the emphasis panel). This permits you to draw attention to particular situations, as well as to selectively export task data for use in other processes. The Automatic Emphasis feature is found on the Options menu item. Note that emphasis is additive - tasks will remain emphasized until their emphasis is cleared, either via the radio buttons for the specific tasks, or by using the Clear all task emphasis button.

Note that to permit re-playing a schedule for educational or forensic purposes, the emphasis calendar also provides the means to permit any date to be set as "Today".

### Group/Heading levels

If necessary, tasks may be arranged in related groups. This is achieved by settings in the Row Options area at the lower left of the window.

Three levels of grouping are possible. Durations may not be assigned to rows defined as group headers. Dates are shown greyed-out at the group level, as if the tasks in the group were a single task.

Costs (Pro feature) are pyramided up the levels. The costs for a task are added into the Group/Heading level immediately above it. A level 3 summary is added into the Level 2 summary above it and a level 2 summary is added into the Level 1 summary above it.

### Moving or Rearranging Tasks

To aid in grouping tasks, you may wish to re-arrange the rows. In order to do this, right click on the row which you wish to move and select the Pick Up Row function then click on the place where you wish to put it down.

### Show More Rows button

The spreadsheet view of the project normally shows basic details of six tasks in the top portion of the window and other details for the currently selected task in the lower portion of the window. Clicking on the Show More Rows button will fill the window with the basic task details grid. Clicking the button again (its caption will have changed accordingly) will restore the original length.

### Precedence (Link) Details

Linkages may be added or changed using the Precedence Details grid. Clicking on the Add Precedent or Edit Precedent button will display a panel for adding or editing a precedent to the task currently selected in the Task Grid.

Only tasks which may be validly be assigned as precedents to the currently selected task are presented on this panel.

The Delete Precedent button will delete the currently selected precedent. If the Precedent Details grid is currently selected, the [INSERT] button will act like the Add Precedent button and the [DELETE] key will act like the Delete Precedent button.

Most precedents are of the Finish-To-Start form, where the precedent task must be completed before the dependent task may be started and the tasks may not overlap in time. In some cases, tasks may overlap. For example, when laying a pipeline it is not necessary to wait until all of the ditch has been dug before commencing to lay the pipe. However, the ditch must be started before laying pipe may be completed. These are known as Start-To-Start and Finish-To-Finish precedences. They may be defined by checking the appropriate box to permit task overlap. Note that Start To Start and Finish To Finish precedences may both be defined between tasks but otherwise one and one only precedent relationship must be defined.

Sometimes an overlapping task may take a shorter time than the one it is dependent on. In that case, the left hand end of the bar on the gantt chart is left uncoloured so that the coloured portion still represents the task duration. The task may begin at the uncoloured start of the bar but cannot be completed until the finish of the yellow portion. e.g. in the Pipeline Example, if backfilling took only 4 days in total it could start one working day after laying pipe started but need not start until two days later than that, as shown here:
Occasionally complex constraints arise. In the chart below, the planner has set a constraint that Task 219 cannot **finish** until another task has finished, but another task cannot **start** until Task 219 has started. This creates a situation where Task 219 has an Early Start of 19 July (because of tasks it depends on), a Late Start of 3 Aug (because of another task whose start depends on its start), but cannot finish before 8 Nov (because it cannot finish until another task has finished). Task 219's **duration** is set at 5 days. Quite clearly those 5 days of work must be spread out over time or those constraints cannot be met. PlanBee indicates this situation as shown below, with a reduced height bar extending the period over which the task must be active, while still correctly indicating the total task duration with the full-height bar.

Note that you may have PlanBee adjust the duration and resource level automatically (**Pro** feature) to resolve this type of situation.

Sometimes, there must be a time lag between activities. For example, in the case of the pipeline it may be necessary to allow 120 calendar days to elapse after backfilling before commencing to landscape the right of way, to allow the fill to settle. Such lags may be specified on the precedence editing panel as either working or calendar days.

To aid in understanding and navigation, a list of the dependents of the currently selected task is shown in a yellow list box at the right of the precedent details. Clicking on one of these dependents will select it as the current task.

Precedents of the Finish-To-Start form may also be defined in the PERT window.

**Pro** feature

**Families** of links

There is often a need in a large plan to differentiate between types of link. PlanBee Pro permits a link to be designated as a "Special" link instead of a regular link using the selection box on the **Precedent Definition** panel. Special links may be indicated by different colours (user-selectable on the **Options**… **Change Colours**… menu item).

Special links may also be de-activated in order to see their effect (regular links may not be de-activated) using the **Options**… **Select Active Links**… panel.

For example, you might designate a family of links to ensure that tasks which need a severely limited resource cannot be active at the same time. If later that restriction eases you may simply de-activate those links without needing to delete them.

Links which have been de-activated are shown "greyed out" in the Precedent Details panel.

In a complex plan, you might wish to see only a particular family of links. Other links may be hidden, but remain active, by using the "Hide" options on the **Select Active Links** panel.

You also have the option on the Gantt and PERT screens to show only **critical links** (and marginally critical links if you have specified a criticality margin) or links associated with the currently selected task. **Note that you may select a task by clicking on its PERT box or it's Gantt bar in addition to clicking its row in the spreadsheet view. The currently selected task is indicated by an aqua (pale blue) row number in the spreadsheet view, an aqua box in the PERT window and an aqua border in the Gantt window.**
Navigating Around Your Plan

Navigating around a small plan is easy. However, when a plan has hundreds of rows it becomes more of a chore to find and select a different task in the main task spreadsheet view.

To assist with this PlanBee provides several aids.

**Go Back** button.

Each time you select a different task PlanBee maintains a "trail of breadcrumbs" to help you retrace your steps. Just click on the Go Back button (there are two of them on the screen) to re-select the previously selected task.

**Right Click** on a task name in another list.

When you right-click on a task name in the **Precedent Details** list, that task becomes selected in the main Task List. The same happens with tasks in the **Dependent** list box and the task list box on the **Resource Calendar** panel.

**Select** a task in a chart screen.

When you click on a PERT box or a Gantt bar, that task becomes selected in the main task list.

Grouping your links into "Families" (e.g. Regular, Special A, Special B, etc..) and giving each family a different colour also makes it easier to follow links on a complex plan. You can "hide" links by family to avoid visual confusion on the screen.

Fixed Dates

Sometimes you may wish to force a task to finish on a given date. To do this, select the task in the spreadsheet window and then check the **Fixed Finish** box in the **Row Options** section in the lower portion of the screen. A calendar will be presented for you to select the finish date for this task. The dates for any tasks with fixed dates set will display as purple on the screen.

This is usually used for reporting the completion of a task, in order to update the remainder of a plan. However, it may also be used to insert fixed future deadlines to test whether they may be met.

Note that you may force impossible times on other tasks by doing this, and they will show up as "negative float".

Exporting Results to Clipboard

When you are viewing the spreadsheet view of the project, you may copy many task details to the system clipboard or to a comma-delimited or tab-delimited file by selecting that function from the **Edit** menu or by clicking the button on the toolbar. You may then paste or import these results into a spreadsheet program or other program which is able to handle a matrix of data. If pasted into a word processor, the columns are separated by tabs and the rows by carriage return/linefeed characters. If using Microsoft Word, this may be converted to a Word table by highlighting and then using the "Convert Text To Table" function.

The details exportable for each task row in this manner are selectable:

- Task Name (always included)
- Row Number
- Duration
- Early Start
- Late Start
- Early Finish
- Late Finish
- Float
- Cost
- Cost Code
- Manager
- Unique Key
- Percent Complete
- Task Notes
- Status Number
Note that some exportable data is meaningful only for plans produced with PlanBee Pro, PlanBee Basic does not have the facilities to create or edit that data.

Task rows to be exported are also selectable:

- Include a row with Column Names
- Export All Rows
- Export Heading Rows Only
- Export Headings and Emphasized
- Export Emphasized Tasks Only

Uncheck the

- Include details for Group/Headers

box only if you are certain that this will not cause problems in the target application - some may require data in all columns of pasted data.

Extremely sophisticated reporting is possible with external database, spreadsheet and word processing products when such selections are performed. In particular, the ability to emphasize tasks and to export based on emphasis is valuable in this context.

**Recalculation Options**

PlanBee normally recalculates the dates of a project automatically after you make a change which will affect them. To avoid slowing you down it waits until you have stopped entering items before doing this. On a slow computer or with a large project (hundreds of tasks), this may result in unacceptable delays. To avoid this, you may turn off the Auto-Recalculation option by unchecking that option on the File menu. You will then be required to initiate recalculation yourself by pressing the F9 key (just like in a spreadsheet) or by clicking on the toolbar button which is enabled (i.e. not Greyed-Out) when Auto-Recalculation is off. To ensure that a recalculation takes place immediately you may press F9 at any time.

**Float and Criticality Options**

Float may be expressed either in calendar days, or in working days based on the Working Day Calendar used for the project. This option is selected by checking a box on the Project Details panel (repeated for convenience on the panel accessed from the Options... Float and Criticality Options... menu item).

**Pro feature** In a large plan, the critical path might change frequently during project planning if several parallel paths are similar in elapsed time. To avoid having this sensitivity cause a problem, PlanBee Pro allows you to specify a Criticality Margin so that "almost critical" tasks are also flagged. This option is selected by checking a box on the panel accessed from the Options... Float and Criticality Options... menu item. Marginally critical and truly critical (i.e. zero float) tasks and links may be indicated by different colours.

**Administrative Details**

**Pro feature** Clicking the button on the toolbar opens the Administrative Details panel:

This panel allows you to maintain additional data which is frequently required for larger plans in a corporate setting.

Tasks which have notes associated with them are indicated by a paperclip symbol next to the row number.

The Cost Code entered is used optionally in the PlanBee reports and is exportable for use in other processes. Multiple tasks may be assigned the same cost code.

The resource costs incurred by a task are calculated based on the per-day cost of the resources assigned to the task. Frequently a task also has costs which are independent of its duration and of the resources assigned (for example a permit fee may be required). Costs such as this are added as a "One time Event Cost". A reason for the one-time cost may be entered in a box which appears when a non-zero amount is entered as a One-time Event Cost. The event costs and the resource costs are calculated for each task and pyramided up to the higher group/header levels.
In many cases a "unique key" or code must be assigned to a task to relate it to external data. PlanBee permits you to enter such a code and ensures that it is unique - duplicates are not permitted to be entered.

The name of a "manager" may be entered. This is likely to be the person or authority responsible for the performance of the task. It is exportable and in a large organization will probably comprise the email address of such a person, so that an external process using exported data may send notes automatically.

**Language for Dates**

PlanBee basic uses the local language in which Windows was installed for the expression of dates in its charts and reports.

**Pro feature** PlanBee Pro provides, in addition, the pre-programmed ability to express dates in English, French, German and Spanish. It also provides the ability to use Roman numerals instead of day or month names and to enter and save day and month names in any other language. This function is found on the **Options... Language Options For Dates...** menu item.

**Resource Assignment**

**Pro feature** PlanBee can keep track of the resources assigned to a project and of the associated costs. To invoke this feature, from the Spread Sheet view depress the Resources button on the toolbar. PlanBee will display a resource list for the currently selected task:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Cost</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreman</td>
<td>1900</td>
<td>0.50</td>
</tr>
<tr>
<td>Labourer</td>
<td>1200</td>
<td>200</td>
</tr>
<tr>
<td>Welder</td>
<td>3000</td>
<td>1.00</td>
</tr>
<tr>
<td>Truck</td>
<td>690</td>
<td>0.50</td>
</tr>
</tbody>
</table>

and a Resources Master list.

To add an item to the Resource Master list, you may click on the Add Resource button and enter its details in the row which will be displayed. You may change the sequence of items in the Resource Master List by "Drag and Drop" with your mouse. The sequence of resources in the resource calendar will also change to match.

You may delete the currently selected item from the Master Resource List by pressing the [CTRL][DELETE] key combination, provided that the resource is not in use in the current project.

You may change the name of a resource by editing its entry in the master resource list and the matching changes will be made throughout the project (e.g. you might have a first-line supervisor position called "foreman" but you want to refer to it as "Supervisor" for the current project - try this on the "pipeline" sample file).

You may (but are not required to) also add a limit to the number of a resource available to the project. If the limit is exceeded you will be alerted in the **Resource Calendar**.

Note that changing the Resource Master List in a project does not alter any copies of that list saved elsewhere unless it is re-saved. The Master Resource List for a project is saved as part of that project file.

To add a resource to the currently selected task, select that resource and then click on the **Add ...to ...** button and then insert the number of that resource being assigned if you want a number other than one, which is added by default. Each time you click the button one more item of that resource is added. You may edit the amount yourself and may use two decimal places in the amount of a resource assigned. The cost of that resource for that task will be computed using the task duration and the cost per day figure from the resource master list.

**The Resource Calendar**

**Pro feature**

The Resource Calendar gives details of how resources are used by the various tasks. It appears when the toolbar button is depressed.
The right hand panel provides a matrix with resources along the top and dates down, covering the whole period of the project.

The repeated button permits toggling off and on of the Resource Master list and Resource Assignment panels. The Resource Calendar panel is closed by using the [X] button on its own toolbar.

Notice in the matrix that the "Date" header is red, as is the "Labourer" column header and the 28-Dec-1999 row header. The red colour indicates a resource overload, as may be seen in the cell at the intersection.

This gives you feedback about resource overloads as you are adding resources to tasks. You may then decide to increase the amount of that resource available to the project, to take some action which will move the starting date of that activity or some other activity or to lower the resource usage per day by adjusting the duration of the task to maintain the same number of resource-days. PlanBee Pro provides several tools to assist with resource leveling.

The left hand panel shows the tasks which use the selected resource on the date selected (or optionally on any date). Right-clicking on one of these task names will bring that task into focus on the main panel to make it easier for you to adjust resource use.

Clicking the button will maximize the grid to fill the window, to give a broader picture of the resource/date matrix.

This matrix may be exported by using the button for use in other programs - for example exporting into Microsoft Excel permitted construction of a graphical chart of resource usage:

**Resource Leveling Techniques**

**Pro feature**

Once you have prepared your plan, you may find that you have a situation where you sometimes need more of a resource than is available. There are several ways in which you may resolve this situation, however some of them may delay the overall project completion. PlanBee helps you to analyse your possible strategies, by showing you their likely outcomes.

Force a task to move its timing:
PlanBee permits you to **fix the finish time** of a task. Although this is mainly provided for inserting known finish dates for completion reporting, it also permits you to set a fixed future date for a task to finish and to see what effect that has on other tasks and on the overall project. PlanBee also permits you to delay the start of a task, to “nudge” it ahead in time by using the **Can’t start before** option. In this case, if you adjust some other task the task you “nudged” may move ahead even more. The task is not fixed in time, merely constrained not to start before a given date. These options are available by checking the appropriate box: , however only one may be selected for any given task.

**Set resource constraint precedents:**

PlanBee Pro permits you to have several "Families" of dependencies in a plan, and to activate and de-activate them. You could set a "special" precedent from the finish of one conflicting task to the start of the other, so that may not be active at the same time. If you have set several of these, and wish to see how resource constraints are affecting your overall project, you may de-activate that family of constraints using the **Options… Select precedence Links to Use…** menu selection.

**Task Spreading:**

Sometimes you can resolve a resource conflict by spreading a task over a longer period so that less work needs to be done per day. For example, in the simplified pipeline project the task “Assemble Crews” and “Assemble Equipment” both require 60% of the time of a foreman - one for 3 days and one for five days.

Since those task overlap, there is a resource overload, as shown in the resource calendar:

![Resource Calendar](image)

Clicking the button on the Resource Calendar toolbar brings up this panel

![Adjust Task Duration and Resources](image)

which permits you to adjust the duration of a task while keeping the total work constant in resource-days.

Here PlanBee has detected that the "Assemble Equipment" task may be spread over a greater period, without affecting any other tasks (i.e. it has "Free Float"). Clicking the “Spread Task” button will increase the duration of the "Assemble Equipment" task, while reducing the resource usage per day to maintain the same total resource-hours of work. Alternatively, you may enter a new duration of your choice in the edit box and click the "Change..." button. PlanBee will also detect and display if appropriate situations where a task may start earlier than scheduled (because it has a finish-to-finish dependency) or where it may finish later without affecting the finish date of the plan, but will affect other tasks (i.e. it has "Interfering Float"). Because this is often a trial-and-error process, an "undo" function is provided. (The "undo" data is maintained in a file with the same name as the plan, but with the extension "UNDO" - you may delete this file once you are sure that you are satisfied with your task spreading.)

In the example chosen, spreading the task over 5 days requires 36% of the foreman's time and brings resource usage under the limit.
Saving and Loading the Resource Master List

If you wish to use the same Master Resource List for another project, you may save it using the Save Master Resource List function of the File menu. You may load a Master Resource List by using the Load Master Resource List function on the File menu, provided you do so before you have assigned any resources in the current project.

PERT View

Another common representation of projects is the PERT chart, shown above. This view will be displayed in its own window when the PERT button on the main window's toolbar is depressed.

The PERT window may be re-sized by "dragging" its borders with the mouse. The size of the elements may be changed by using the "Scale" buttons, which will change the number of tasks shown on the screen or printed on a page.

Note that the currently selected task is shown on a pale blue background and that the selected row in the spreadsheet window and the selected task box in the PERT window are kept synchronized. If you click on a node in the PERT view, that task becomes the current selection in the spreadsheet view and if you click on a task in the spreadsheet view, that task's node appears in the PERT view window.

Many operations in PlanBee can be conducted from the PERT view of a project. The name and duration of a task may be edited in the boxes above the chart (however, specifying working or non-working days must be done in the spreadsheet view).
The following functions may be performed by right-clicking on the PERT chart nodes

<table>
<thead>
<tr>
<th>Function</th>
<th>Valid for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Task</td>
<td>Empty position</td>
<td>Create a new task in the selected position on the chart. You may add task name and duration in the boxes at the head of the chart.</td>
</tr>
<tr>
<td>Delete This Task</td>
<td>Occupied Position</td>
<td>Delete the selected task provided that there are no links involving it. Links must be removed using the Spread Sheet view.</td>
</tr>
<tr>
<td>Pick Up This Task</td>
<td>Occupied Position</td>
<td>You may wish to move a task to a different location on the chart. Right clicking it and then selecting this function will &quot;pick up&quot; the task. You may then select an empty position for it and put it down either by left-clicking the desired position or by right clicking it and selecting &quot;put down&quot;.</td>
</tr>
<tr>
<td>Put Down Picked Up Task</td>
<td>Empty position</td>
<td>See above.</td>
</tr>
<tr>
<td>Add Precedent Link*</td>
<td>Occupied Position</td>
<td>When this function is selected, a precedent link is created leading to this task. The other end of the link is set by left-clicking on the precedent task or by right-clicking on the precedent task and selecting Complete Pending Link.</td>
</tr>
<tr>
<td>Add Dependent Link*</td>
<td>Occupied Position</td>
<td>When this function is selected, a dependent link is created leading from this task. The other end of the link is set by left-clicking on the dependent task or by right-clicking on the dependent task and selecting Complete Pending Link.</td>
</tr>
<tr>
<td>Complete Pending Link</td>
<td>Occupied Position</td>
<td>See above</td>
</tr>
<tr>
<td>Cancel Pending Action</td>
<td>Any position</td>
<td>Cancel any pending action started by a right-click on the PERT chart.</td>
</tr>
</tbody>
</table>

*Note that the system will not allow you to specify a link which would create circular dependencies.

Auto Alignment of PERT chart.

If you wish to "unscramble" a convoluted chart, you may click on the "AutoAlign" button to have PlanBee arrange your nodes in a way which seems logical to it. Usually you will only want this if you have made some changes which involve deleting tasks, or if you have specified some tasks in the Spread Sheet view, which does not assign chart positions. If you do not like the details of the alignment which results you may move specific tasks by "picking them up" using the right-click menu in the PERT window.

Printing a PERT Chart

The "Printed Pages" note tells you how many pages it will take to print your current chart on the currently selected orientation (portrait or landscape) of the currently selected paper of the currently selected printer. You may adjust the scale of the chart for both screen and printer purposes by clicking the "Scale" buttons. Frequently a chart under-uses the last pages of a printout and may be fitted onto a smaller number of pages by setting a slightly smaller scale.

The chart may be printed either by selecting the Print Pert Chart function on the File menu or by clicking on the printer icon in the PERT window.

Using PERT Chart in other applications

In order to use the chart in other applications, the Edit menu of the PERT form provides the means to copy the chart to the clipboard either as a bitmap of the currently displayed portion (ideal for pasting into a word processor when writing a report) or as a vector graphic of the whole chart for pasting into a vector graphics program such as Corel Draw or for output to a large format vector device like a plotter.
GANTT (Bar Chart) View of Project

A popular way to visualize the timing of a project is to view it as a GANTT Chart, often called a Bar Chart or a Time Line.

PlanBee maintains a Gantt Chart in its own window, which may be shown or hidden by toggling the Gantt button on the toolbar.

This chart can show both the planned timing for tasks and the proportion of a task which has been completed.

If something is of zero duration it is known as an "event". It is shown with a diamond shape:

since otherwise there would be no method of indicating completion by filling the shape with silver shading.

The chart may be copied to the clipboard by clicking on the "Clipboard" icon, or printed by clicking on the "Printer" icon. Copying the chart to the clipboard is a convenient way of incorporating it (or parts of it) in another application such as a report.

The size of the Gantt window may be changed by "dragging" its borders with the mouse.

The Time Scale buttons allow you to squeeze or expand the time scale which is useful for the Clipboard and Printer operations as well as for direct viewing. The display shows the number of printed pages which will result.

Note that sometimes switching to printing in "Landscape" format may result in more efficient use of paper.

When copying the chart to the clipboard, you may adjust the size and scale of the chart before clicking the clipboard button to choose what you will paste into your other application. If you are transferring a large chart into another document in several pieces you may wish to use a different scale for the different pieces.

Although not a usual feature of Gantt charts, PlanBee allows you to show the dependencies between tasks as purple arrows (like those in the PERT view) when you check the "Show Dependencies" box.

In some circumstances you may wish to print a bar chart showing durations and progress only, without the "float" portions. You may do this by unchecking the "Show Float" box before printing.

You may see other details concerning Gantt Charts in the introduction section.

The Gantt chart is auto-positioned in its window so that when you click on a task in the spread sheet view it will be in the portion of the chart displayed. You may turn this feature off by unchecking the box in the Gantt window.

Reporting Progress with PlanBee

PlanBee permits you to keep track of progress on your projects. When the progress reporting button on the toolbar is depressed, a progress reporting panel is displayed. The status of the currently selected task may be entered by clicking the appropriate button.

The progress of a task is also indicated by a grey "thermometer bar" across the top of its task name.
In printed reports, the progress of a task is shown by means of a circular target with a black segment indicating progress once progress has commenced for that item.

All progress items in a project may be zeroed-out by using the appropriate button on the Project Options panel. This may be useful for handling a project which is repeated several times, just clear the progress and choose a new start date.

If you wish to re-calculate your plan based on a task being completed earlier or later than scheduled, you may set its actual finish time by checkmarking the green Fixed Finish box and selecting the actual finish date. If you wish, you may have PlanBee calculate and insert percent complete figures for tasks when you set a fixed finish date by checkmarking the box. Since estimates of "percent complete" can be very inaccurate it is advisable to define tasks with short durations (a week to a month is good) and to report actual completion dates.

There is also a short-cut button on the "Percent Complete" panel to mark all tasks as 'Up to date'.

Printing Reports

The printing function for text reports is located on the File menu. The View/Print Report function displays a panel showing a preview of the printed report.

The following options may be checkmarked:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action if checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Line Numbers</td>
<td>Each task or heading line of the output report will be listed with its task list row number for reference purposes</td>
</tr>
<tr>
<td>Show Precedent Relationships</td>
<td>The precedents for each task will be listed, with details of the type of dependency. Where there are multiple precedents, the one which governs the task timing of the dependent is indicated.</td>
</tr>
<tr>
<td><strong>Pro</strong> feature Resources</td>
<td>The resources assigned to each task are included in the report.</td>
</tr>
<tr>
<td><strong>Pro</strong> feature Costs</td>
<td>The costs for each activity are listed and totaled for the activity. If there are group/heading levels shown, costs at each level are subtotaled.</td>
</tr>
<tr>
<td><strong>Pro</strong> feature Notes</td>
<td>Include Task Notes from Administrative Details</td>
</tr>
<tr>
<td><strong>Pro</strong> feature Manager</td>
<td>Include Manager name or code from Administrative Details</td>
</tr>
<tr>
<td><strong>Pro</strong> feature Unique Key</td>
<td>Include Unique key from Administrative Details</td>
</tr>
</tbody>
</table>

The report may be copied to the clipboard by clicking on the icon. It may be directed to the printer by clicking on the icon. Note that you may create your own reports by using the function to export results via the clipboard. This gives you the ability to format your own reports with a word processing or spreadsheet program.
The Sample Plans
Several sample plans are included to give you the opportunity to become familiar with the system:

Newsletter:
Most groups or departments need at some time to issue a newsletter. This example will therefore be familiar to most.

Charity Lottery:
In many jurisdictions, charities or non-profits may conduct lotteries only under government supervision. This usually involves legal deadlines expressed in calendar, rather than working, days.

Pipeline:
This (contrived and simplified) example is included to show the operation of various kinds of dependencies and time lags, including finish-to-start, start-to-start and finish-to-finish.
It also demonstrates the use of headings and groups to enhance reporting and to subtotal resource costs.

Advertising Campaign:
This is an example of a product launch with three simultaneous campaigns.

The Great Mail Train Robbery
Just after 3 o'clock in the morning, Thursday 8th August 1963, on a stretch of railway track in Buckinghamshire, England sixteen men ambushed the Glasgow-to-London main train. Their total booty that night was £2,631,784 - worth over £26 million ($20,000,000) today.

"CHEDDINGTON, England--A well-drilled gang of about 30 masked bandits ambushed a mail train Thursday and escaped with loot estimated at millions of dollars in perhaps the biggest robbery of all time.

"The job was executed at 3:15 a.m., 40 miles north of London with precision and teamwork that pointed to the strategy of an underworld mastermind who has met with success in previous British train and bullion robberies.

"The gang first overpowered the railway signalman and set the signals for 'danger,' stopping the train. They seized the engineer and fireman, expertly uncoupled the engine and the first two cars, forced the engineer to drive them a mile down the track, then, smoothly swept up 120 mail sacks containing cash and diamonds.

"They made a getaway in two army-style trucks and a fast car. ...

"The ambush occurred at a lonely crossing by a signal which the bandits had rigged to appear red. They did not disturb electronic 'fail-safe' gadgets, but covered the green signal with a glove and used flashlights to shine a light through the red panel of the signal. The train halted exactly where they wanted it.

"When Co-Engineer David Whitby, 26, stepped down to see what was wrong with the signals, he and Engineer Jack Mills, 58, were seized by one group of bandits wearing silk stockings over their heads.

"At the same time, another group uncoupled the first two coaches, while postal workers in the remaining seven cars continued their routine unaware of the drama up front. ...

"The entire operation ... took only 15 minutes."

--compiled by Susan Schuurman

Source: Albuquerque Journal;
Aug. 9, 1963

In a book published shortly afterwards (Network Analysis for Planning and Scheduling - MacMillan & Co Ltd), a British university lecturer in Management Science, Albert Battersby suggested that a robbery of such complexity was probably planned using critical path techniques. He suggested that Law Enforcement agencies could benefit from studying such plans on a theoretical basis to determine their weaknesses. He designed and published such a plan for robbing a mail train and this example is based on his plan. Do not try this at home.
Upgrades & Fixes

Any upgrades, maintenance releases and frequently asked questions will be posted at http://www.guysoftware.com/planbee.htm
Clicking on this link will connect you if you have a recent browser and an Internet connection.

Uninstalling PlanBee

The standard PlanBee installation routine sets up an uninstall facility. To use it, select MyComputer, ControlPanel, Add/Remove
then select PlanBee and click Add/Remove.

To uninstall PlanBee (if not installed by a method which creates an automatic uninstall), simply delete the files in the directory into which you installed it. It does not install any DLLs or similar files on your system.

Reinstalling or Transferring PlanBee

If you wish to reinstall a registered copy of PlanBee or transfer it to a new machine or hard drive, you may do so as follows.

Immediately before the transfer:

Click on the Help menu within PlanBee and select Registration Details. Write down the user name and registration code number which appears.

Transferring your licence:

If you are restoring all of your hard drive files via a backup utility, no further action is required. Your licence is transferred automatically.

If you are installing from a new downloaded copy and you have retained a previous key file which had been emailed to you, process it as originally instructed and your licence will be installed automatically.

If none of the above methods applies, enter the user name and registration code number (which you wrote down before commencing the transfer) in the registration dialog box within 28 days.